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Section 1 - Getting Started Using PC-ACE  

This guide is to be used to assist in setting up PC-ACE for Medicare A/B claim submission to 
National Government Service (NGS). 

Minimum System Requirements 

• SVGA monitor resolution (800 x 600) 
• Windows 10, Windows 8.1, Windows 7 or Vista operating system 

• Adobe Acrobat Reader Version 4.0 or later (for overlaid claim printing) 
 
Note: When the Windows "Large Fonts" display setting is enabled, the screen resolution 
must be 1024 x 768 or higher. The CMS-1500 claim form will not display properly at lower 
screen resolutions.  

PC-ACE Part B Full Install Instructions 

Note: These instructions are designed for use with Microsoft’s Edge, Google Chrome or 
Firefox. The use of other browsers is not supported by the NGS EDI Help Desk. 

Steps 1–7 only need to be completed if you initiate the install from the NGS website home 
page. 

1. Open an Internet browser and go to https://www.NGSMedicare.com. 

2. Select Accept when presented with the Attestation page. 

3. On the NGS landing page, select your line of business and state then select Enter. 

4. Select RESOURCES dropdown at the top of the web page.  

5. Select EDI Solutions. 

6. Select EDI Software PC-ACE then select Download PC-ACE to download the software. 

7. On the PC-ACE Download form, complete all required fields marked with an asterisk 
(*). 

8. Under Select Your Download Below, select the radio button option for PC-ACE Full 
Installation Version X.XX (Institutional and Professional) PC-ACE users.  

9. Select the Submit Request button. 

10. Please note the installation password NGSMAC1 at the top of the page. 

11. Once you have noted the installation password, select the Download button to start 
the download. 

12. A message will appear: ‘What do you want to do with PC-ACE Setup?’. Select Save 
as. 

13. On the left side of the 'Save As' dialogue box, select the Desktop button to save the 
file to your desktop, then select Save. 
Note: If you are using Windows 7 or 8, the buttons on the left may not be present. If this 
is the case, please select Desktop from the Save As: dropdown box. 
Note: NGS does not support the installation of PC-ACE on a network. The file will begin 
to download to your desktop. 

14. A message will appear: 'Download complete'—close the download dialogue box and 
minimize your Internet browser in preparation for step 17. 

15. Launch the setup.zip icon; your unzip wizard should open. Note: Since unzip utilities 
vary, you are responsible for getting this file unzipped to your desktop. Please follow 
the instructions for your unzip utility. 

16. Double Click setup.exe icon on your desktop, which will open the file. 

https://www.ngsmedicare.com/
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17. The Wise Installation Wizard will begin. 

18. Installation code is NGSMAC1. 

19. At the Welcome window, select Next. 

20. At the Drive Selection window, select Next. 

21. At the Start Installation window, select Next. 

22. Follow the online instructions until Finish is selected. 

23. To access PC-ACE, select the PCACE icon and enter the default user ID SYSADMIN and 
the password SYSADMIN. 

24. We recommend downloading additional material to assist you with PC-ACE. After the 
software is successfully downloaded, revisit the EDI Software web page for available 
documentation. 

PC-ACE Part B Upgrade Instructions 

Please Note: Prior to performing this upgrade it is recommended that a backup of your 
current version of PC-ACE is performed. If the version of PC-ACE currently installed is more 
than two versions behind the available version with NGS, please upgrade as soon as 
possible. 

Note: These instructions are designed for use with Microsoft’s Edge, Google Chrome or 
Firefox. The use of other browsers is not supported by the NGS EDI Help Desk. 

1. Open an Internet browser and go to https://www.NGSMedicare.com. 
2. Select Accept when presented with the Attestation page. 
3. On the NGS landing page, select your line of business and state then select Enter. 
4. Select RESOURCES dropdown at the top of the web page.  
5. Select EDI Solutions. 
6. Select EDI Software PC-ACE then Download PC-ACE to download the software. 
7. On the PC-ACE Download form, complete all required fields marked with an asterisk 

(*). 
8. Under Select Your Download Below, select the radio button option for PC-ACE 

Upgrade (Institutional and Professional) PC-ACE users Version X.XX. 
9. Select Submit Request button.  
10. Please note the installation password NGSMAC1 at the top of the web page. 
11. Once you have noted the installation code, select the Download button to start the 

download. 
12. A message will appear: Do you want to open or save this file?  Select Save  
13. On the left side of the Save In dialogue box, select the Desktop button to save the file 

to your desktop, then select Save. 
Note: If you are using Windows 7 or 8, the buttons on the left may not be present. If 
this is the case please select Desktop from the Save in: dropdown box.  

          Note: We do not support the installation of PC-ACE on a network.  
14. The file will begin to download to your desktop. 
15. A message will appear: Download complete. Close the download dialogue box and 

minimize your Internet browser in preparation for step 16. 
16. Launch pcaceup.zip; your unzip wizard should open. Note: Since unzip utilities vary, 

you are responsible for getting this file unzipped to your desktop. Please follow the 
instructions for your unzip utility. 

17. Double Click pcaceup.exe icon on your desktop. 
18. The Wise Installation Wizard will begin. 
19. Installation code is NGSMAC1, (not case sensitive) and select OK. 

https://www.ngsmedicare.com/
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20. A message will appear asking if a system backup has been performed.  
a. If the answer is yes, select Yes to proceed with the update 
b. If the answer is No, make a backup as follows:  

 Select the No button, and then click the OK button in the Update 
Cancellation Notice window; the installation wizard will close 

 Launch PC-ACE and, on the main toolbar, select the System Utilities button 
(last button on the right) 

 On the Backup/Restore tab, select the Backup sub tab 
 If there is a path to your normal backup folder in the Destination Drive or 

Folder field, select the Start Backup button and proceed as you normally 
do for a backup, then return to step 4 

 If the Destination Drive or Folder field is empty, select the small button to 
the right of that field (has 3 dots on it), browse to the folder you wish to save 
your backup to and select the Open button, then select the Start Backup 
button 

 In the Confirm window, select the OK button; wait while the backup 
completes 

 After the backup completes, an Information window will appear stating 
that your backup has completed successfully; select the OK button. 

 Close PC-ACE and return to step 12. 
21. Follow the online instructions until Finish is selected. 
22. The PC-ACE Backup Reminder dialogue box will appear advising that the update 

was completed successfully. It will also recommend that you make a new backup of 
PC-ACE now that it has been upgraded to the current version (you should perform 
this backup after you have confirmed that you can open a claim and/or a patient file 
without receiving an error message); select OK. 

23. To access PC-ACE, select the PCACE icon and enter the default user ID SYSADMIN 
and the password SYSADMIN. 

24. We recommend downloading additional material to assist you with PC-ACE. After 
the software has been successfully downloaded, revisit the EDI Software webpage 
for available documentation. 

 

Logging Into PC-ACE for the First Time 

1. Upon installation of the PC-ACE software, from the Desktop click on the PC-ACE icon 
to open the software (Figure 1). 

  Figure 1 

2. Enter “SYSADMIN” in the User ID and Password fields in the Sign On box and select 
OK (Figure 2). 

 

 
 
 
 

Figure 2 
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Important: If concerned about controlling User access, the default User’s password 
can be changed under Security and Maintenance. For instructions on changing User 
access, please use the PC-ACE User’s Manual for instructions on setting up individual 
users. Note: NGS is unable to change, modify or reset any individual passwords once 
they have been setup in your PC-ACE software.  

Online Help Feature 

The PC-ACE program has an online help feature that can be accessed from the PC-ACE 
Claims Processing System main menu. 

1. Select Help, and then select Help Topics (Figure 3). 

 Figure 3 
2. Select the Index tab (Figure 4). 

a. To search for a particular subject, type a few letters of the word. 
b. Select the index entry to be reviewed, and select Display. That 

portion of the topic will appear. Review or Print the information. 
 

  Figure 4 

 

Section 2 - Reference File Maintenance 

Reference File Maintenance records must be completed in order to begin utilizing the PC-
ACE Software. 
 

1. Select the Reference File Maintenance folder (yellow folder) (Figure 5). 
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  Figure 5 
 

Patient Setup 

The Patient tab allows the addition and maintenance of patient information, including the 
patient's primary and secondary insured details. 

• The setup of the Patient’s information is optional. The patient information will not be 
accessible during claim entry or claim import if the patient database is not set up. 

• The complete patient list will be accessible during claim entry using the variable-list 
lookup feature if the patient record is set up. When a patient is selected from the 
lookup list during claim entry, all applicable patient information will auto populate 
to the appropriate claim form fields. 

• Once the patients are added, the Patient tab provides a convenient Sort By selection 
that quickly sorts the patient list by Patient PCN or Patient Name under the List Filter 
Options (Figure 6).  (Use the F1 function key for more information). 

 

  Figure 6 
 

• A number of fields on the Patient/Insured Information tabs support data entry via fixed-
list or variable-list lookups. These lookup lists are accessed by right-clicking the 
mouse in the field or pressing the F2 key in the field. 

• Helpful fly hover-over hints are also available for many fields by left-clicking in a field 
or hover the mouse over the field. 

1. To add a new patient record, click the New button (Figure 7). 
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  Figure 7 
 

2. Enter the Patient Information on the following tabs (Figure 8): 
• General Information - general patient information such as the patient's name, 

address, birthdate, and various status flags. 
• Extended Info - extended patient information such as information on the 

patient's primary Provider ID. 
• Primary Insured - payer, insured, and employer information for the primary 

Institutional payer(s). 
• Secondary Insured - insured information for the secondary institutional 

payer(s). 
• Tertiary Insured - insured information for the tertiary institutional payer(s). 

 

  Figure 8 
 

3. After completing data entry on the Patient Information form, click the Save button to 
save and exit the form (Figure 9). 

 
 
 
 
 
 

  
 

 
Figure 9 
 

4. During the patient save operation, an edit validation process is performed on all 
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patient record fields. If no edit validation errors occur, no further correction is needed 
and the patient record will be saved. 

When edit validation errors occur, double-click the first error message to jump to the 
corresponding field.  Several Save attempts may be required when there are multiple 
errors to correct and save a "clean" patient record (Figure 10). 

 Figure 10 

Payer Setup 

The payer information for Medicare is already present in the PC-ACE software by default. 
Add additional Payer records for other lines of business to include these payers on newly 
entered claims. 

1. To set up additional payers, select the Payer tab. (Figure 11).

2. Select New to open the payer information screen.

 Figure 11 

3. Enter the new payer’s information taking advantage of the built-in lookups where
possible by pressing the F2 key or right-clicking the mouse in the fields highlighted
below (Figure 12).
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 Figure 12 
 
 
 

4. The Payer Information window will be displayed.  Enter all the appropriate 
information in the highlighted in the following fields. 
 

Use the mouse to click into a field or press the <Tab> button to progress through the 
form. Complete the following information (Figure 13): 

 

  Figure 13 
 

Payer ID Enter the Other Payers National Identification number. 
If unknown, enter a value of choice as this is a required field 
Examples:  
9999BSCB for Blue Cross and Blue Shield 
8888AETNA for Aetna 
7777MC for Medicaid 

LOB F2 or right click in this field and select the LOB for the desired 
Payer 

Full Description Enter the Company name 

Source F2 or right click in this field and select the corresponding Payer 
source 

5. All other fields should remain blank and select Save. 
6. Repeat the relevant steps to create additional Payer records as needed. 

7. Click Close when finished (Figure 14). 
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Figure 14 

Medicare Solo Provider Setup 

To set up an individual provider number electronically, set up must be in a ten-digit format 
for the NPI. 

Note: Instructions for group provider and individual group members set up in the next 
section. 

1. From the PC-ACE Claims Processing System main menu select Reference File
Maintenance (yellow folder) (Figure 15).

 Figure 15 

2. Select Provider (Prof) tab (Figure 16).

   Figure 16 

3. Select New.

4. Enter the following information: (Figure 17)
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 Figure 17 

Field Name Action 
Provider Type Select Solo Practice button. 
Last/First/MI Enter practitioner’s name. 
Address Enter practitioner’s address. 
City/St/Zip Enter practitioner’s city, state, and ZIP Code. 
Phone Enter office phone number. 
Contact Enter contact name for office. 
Provider ID/No. Use the ten-digit NPI number. 
LOB Press <F2> key to show list, then select MCB. 
Payer ID Press <F2> key to show list, then select the appropriate payer ID.  
NPI Enter ten-digit NPI number. 
Tax ID Enter Social Security Number (SSN) or Employer Identification 

Number (EIN) 
Type Enter “S” for SSN or “E” for EIN. 
Specialty Press <F2> key to show list, then select the appropriate specialty. 
Type Org Press <F2> key to show list, then select the appropriate Org. 
Accept Assign? Press <F2> key to show list, then select the appropriate assign 

code. 
Participating? Press <F2> key to show list, then select Y or N. 
Signature Ind Press <F2> key to show list, then select Y or N. 
Signature Date Enter EDI agreement was signed for electronic billing. 

5. Select the Extended Info tab (Figure 18)
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  Figure 18 

6. Select Close to exit the Reference File Maintenance box (Figure 19). 

 Figure 19 

 

Group Record Setup for Medicare 

1. Select Reference File Maintenance (yellow folder) from the PC-ACE Claims 
Processing System main menu. (Figure 20). 

 Figure 20 

2. Select the Provider (Prof) tab (Figure 21). 

3. Select New. 
 

  Figure 21 

4. New Provider Options box appears with Create a completely new provider (all fields 
blank) button selected. 

5. Select OK (Figure 22). 
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   Figure 22 

6. Enter the following information (Figure 23).

Figure 23

Field Name Action 
Provider Type Select Group Practice button. 
Group Name Enter group name. 
Address Enter group service location. 
City/St/Zip Enter group city, state, and ZIP Code. 
Phone    Enter office phone number. 
Fax Optional field 
Contact Enter office contact name. 
Group ID/No. Enter ten-digit group NPI number. 
LOB Press <F2> key to show list, then and select MCB. 
Payer ID Press <F2> key to show list, then select the appropriate payer ID. 
Group Label  Enter an abbreviation of choice to link the group to individual 

records.  
Note: The group label is very important. A user-assigned identifier 
that is used to link the group and individuals within the group (e.g., 
“AMD” for American Medical Doctors) group label is assigned by 
the provider. 

NPI Enter the group NPI number. 
Tax ID/Type Enter tax identification number and “E” for tax ID. 
Specialty Press <F2> key to show list, then select appropriate specialty.  
Type Org Press <F2> key to show list, then select appropriate Org  
Accept Assign? Press <F2> key to show list, then select appropriate assign code.  

Field Name Action 
Participating? Press <F2> key to show list, then select Y or N 
Signature Ind Press <F2> key to show list, then select Y or N 
Signature Date Enter date EDI agreement was signed for electronic billing. 
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7. Select the Extended Info tab (Figure 24).

8. Enter CLIA No./Mammography No. if appropriate.

9. Enter “XX” for the NPI in the Provider ID/No Type field.

10. Select Save.

 Figure 24 

Individual Group Member Record Setup for Medicare 

1. Highlight group record and select New (Figure 25).

2. Select Inherit name/address information from the selected provider

3. Select OK

  Figure 25 

4. Change Group Practice to ‘Individual in Group’ (Figure 26).
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 Figure 26 

Field Name Action 
Provider Type Select Individual in Group button. 
Last/First/MI Enter name of provider. 
Provider ID/No. Remove group NPI and enter ten-digit NPI number of individual. 
LOB Press <F2> key to show list, then select MCB. 
Payer ID Press <F2> key to show list, then select appropriate payer ID. 
Group Label Press <F2> key to show the Provider/Group Selection list, click on 

the Group Record and click Select. 
NPI Remove the group NPI, and enter the individual NPI number. 
Specialty Press <F2> key to show list, then select the appropriate specialty 

ID. 

5. Select the Extended Info tab (Figure 27).

6. Enter CLIA No./Mammography No. if appropriate.

7. Enter “XX” for the NPI in the Provider ID/No Type field.

8. Select Save.

9. Select Close to exit the Reference File Maintenance.

 Figure 27 

Submitter Setup 
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1. Select the tab marked Codes/Misc (Figure 28).
2. Select SUBMITTER.

  Figure 28 
3.  The radio button defaults to Institutional. Select Professional and Select

View/Update with the submitter record highlighted (Figure 29).

 Figure 29 

General Tab 

4. Enter submitter number (e.g., NYBXXXX, CHXXXXXXX) in the ID field (Figure 30).
5. Enter name and address of submitter.
6. Enter phone number and contact.
7. Select Save.

 Figure 30 

Referring Physician Setup 

Referring physician National Provider Identifier (NPI) record should be created for all 
doctors ordering diagnostic tests and consultations. 
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1. Select PHYSICIAN on the Provider (Prof) tab (Figure 31).

 Figure 31 

2. Select New (found on bottom left of screen) (Figure 32).

  Figure 32 
3. Enter physician’s last name, first name, and middle initial (Figure 33).
4. Enter physician’s NPI number.
5. Select Save.

  Figure 33 

6. Select Close to exit Physician Information box (Figure 34).

  Figure 34 

Facility Setup 

A facility record must be created for all places of service other than home and office. If a 
modifier QU is utilized for a health professional shortage area (HPSA) location or if there is 
a second provider location within the same pricing jurisdiction, a facility record will need to 
be created. 
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1. Select FACILITY (Figure 35). 

  Figure 35 
 

2. Select New (Figure 36). 

  Figure 36 
 

3. Enter in the following fields:  
 Facility Name 
 Address 
 City/St/Zip 
 NPI number for facility (only needed for purchased services and laboratory) 

4. Select Save. (Figure 37) 

  Figure 37 
 

5. Select Close to exit the Facility Information box (Figure 38). 

  Figure 38 

Charges Master Setup (Optional)  

To have charges automatically populate in charge field, the charges master must be set 
up.  
 

1. Select CHARGES MASTER (Figure 39). 
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  Figure 39 
 

2. Select New (Figure 40). 

  Figure 40 
 

Charges Master Information 

1. Fill in the following: (Figure 41) 
 Enter procedure code in Code field. Description will automatically populate after 

entering procedure code. 
 Enter money amount in Charges field. 

2. Select OK. 

  Figure 41 
 
Repeat the above steps for each code to be entered. 
3. Select Close to close the Charges Master Information box (Figure 42). 

  Figure 42 
 

4. Select Close to exit from the Reference File Maintenance box (Figure 43). 
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  Figure 43 
 

To activate the Charges Master list do the following:  

1. From the PC-ACE Claims Processing System main menu, select File (Figure 44). 

  Figure 44 
 

2. Select Preferences (Figure 45). 

  Figure 45 
 

3. Under the General tab, select Use Charge Master Reference files for Professional 
procedure code lookups (Figure 46). 

4. Select OK. 

  Figure 46 

Section 3 - Claims Entry 

Upon completion of the Reference File Maintenance, claims are now ready to be manually 
entered. When importing claims from another software, the manual entry of claims may be 
bypassed.  Please follow the section on Importing Claims. 

1. Select the PROF icon from the PC-ACE Claims Processing System main menu (Figure 
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47). 
 

 Figure 47 
 

2. Enter SYSADMIN as both the User ID and Password in the Sign On box if it appears 
(Figure 48). 

3. Select OK. 

 

 
 
 
 
 

 
 

 
Figure 48 

 

4. Select Enter Claims to open the Professional Claim Form (Figure 49). 

 

   Figure 49 

Entering Claim Data 

Click on any field to enter data or press the TAB key to move from field to field left to right.  
Use the UP ARROW and DOWN ARROW keys to move up and down through the claim 
form fields, respectively. 
 

A number of productivity enhancing features are available during claim entry: 

• Claim Form Topic Help - Press the <F1> key while entering a Professional claim and 
the software will display the Professional Claim Form topic in PC-ACE. 
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• Fixed-List Lookups – Press the <F2> key or right click in fields containing lookup 
capability to take advantage of the built in fixed-list lookup lists to select from. 

Access the lookup list for a field by positioning the cursor on the field and pressing the 
F2 function key (or right-clicking the mouse). When an item from the list is selected, its 
value is automatically entered in the claim form field.  For example, Patient Sex 
typically has three possible values: "M" (male), "F" (female), and "U" (unknown). 

Type <ALT>F2 (press the <F2> key while holding the <ALT> key down) to identify all 
fields that support a lookup list. Press the <ESC> key to disable the flashing 
notification (Figure 50). 

  Figure 50 
 

• Variable-List Lookups – Applies primarily to fields whose values are selected from 
the reference files completed in Reference File Maintenance in the ‘Getting Started 
Using PC-ACE’ section above. 

 

If any information in the variable-list lookups selected from the reference files is 
incorrect and cannot be changed within the claim form, exit the Claim Form and 
make the necessary change(s) directly to the proper reference file. 
 

For example, selection of a patient from the variable-list lookup completes numerous 
patient- related fields on the claim. Access variable list lookups using the same 
method described above for fixed-list lookups. 

• Right click in the Patient Control No. field (Figure 51). 
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  Figure 51 
 

• Then select the patient that will be entered on the claim form (Figure 52) from the 
reference file Patient Selection to auto-populate the values from the Patient Selection 
record into the claim form (Figure 53). 

   Figure 52 
 

  Figure 53 
Cancel Field Changes - When a change is inadvertently made to the contents of a field, 
press the ESC key to cancel this change and restore the field's original content. This feature 
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is available for some of the claim form fields. 

Enter the appropriate information required for the Professional claim form utilizing the 
mouse to click into a field or press the <TAB> button to progress through the form. 

The sections/tabs display fields in the same order as a hardcopy Professional claim 
form (Figure 54). 

 

The Professional claim form contains six sections (tabs):  

• Patient Info &General  

• Insured Information 

• Billing Line Items 

• Extended Patient/General 

• Extended Patient/General (2) 

• Extended Payer/Insured   

  Figure 54 
 

• Patient Info &General Tab 
This tab includes fields for general claim and patient information. 

 

1. While the cursor is displayed in the Billing Provider field, press the <F2> key to 
show list, then select the appropriate provider (Figure 55). 

If part of a Group, the Billing Provider field should always be populated with the 
Group. 

If a Solo Practitioner, select the Solo record (Figure 56). 
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  Figure 55 
 

  Figure 56 

2. Enter the patient information manually during claim entry or while the cursor is 
displayed in Form Locator 26 – Patient Control Number, press <F2> or right click 
to access a list of patients from which to select in reference file maintenance 
record (Figure 57).  

   Figure 57 

a. Once the patient is highlighted, click SELECT (Figure 58). The Patient Info & 
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General tab will be displayed with data elements populated from the Patient 
Selection record. Press Tab or point and click to make any modifications to a 
form locator on the Patient Info & General tab. 

  Figure 58 

b. If the patient is not in the Patient Selection select New (Figure 59). 

  Figure 59 

c. Enter in the following fields: (Figure 60) 

  Figure 60 

Field Name Action 
Last Name/First Name/MI Enter patient’s name. 
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Patient Control No (PCN) Enter patient’s last name, space, first name 
Or if preferred use a numbering system. 

Address Enter patient’s address. 
City/State/Zip Enter city, state, and ZIP Code. 
Phone  Optional 
Sex Enter “M” for male or “F” for female. 
DOB (date of birth) Enter the date in the MM/DD/CCYY format. 
SOF (signature on file) Press <F2> key to show list, then select the appropriate 

code. 
Release of Info (ROI) Press <F2> key to show list, then select the appropriate 

code. 
ROI Date Enter date released signed or earliest date billing was 

made on this claim. 
Note: Do not select Save. 

 
Select the Primary Insured (Prof) tab (Figure 61). 

  Figure 61 

d. Enter the following information: (Figure 62) 

Field Name Action 
Payer ID Press <F2> key to show list, then select the 

appropriate payer. 
Rel (relationship to insured) Enter “18” for self. 
  Enter “01” for spouse. 
  Enter “19” for child. 
Insured ID Enter Medicare Health Insurance or subscriber 

number. 
Assignment of Benefits Enter “Y” for yes or “N” for no. 

e. Select Save. 

3. The Professional Claim Form box will appear (Figure 62). 

4. In box 10 enter “N” for condition related to employment and “N” for condition related 
to an accident. 

5. In box 20 enter “N” for outside lab charges not included in claim or  “Y” for outside lab 
charges included in claim. 

6. If billing for a place of service other than home, office, enter a “Y” in the Facility? field.  
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  Figure 62 
 

7. When the Facility Information box appears on the Ext. Patient/General tab, press 
the <F2> key for the facility information (Figure 63). 

8. Select the facility.  

Note: Additional facilities may be added by selecting New, then adding the facility 
data, and then selecting Save. 

  Figure 63 
 

• Billing Line Items Tab 
Enter the services/supplies rendered to the patient. Six claim lines are displayed at a 
time on the window. The user can use the <Scroll Up> and <Scroll Down> buttons to 
move up and down within the claim (Figure 64). 
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Figure 64      
      

 

This tab also includes extended line item fields, and line-level MSP/COB fields. For 
detailed information on entering Medicare Secondary Payer claims, download the PC-
ACE Medicare Secondary Payer (MSP) Reference Guide.  

• Line Item Scrolling - The Billing Line Items tab displays 6 claim lines at a time. For 
claims that contain more than 6 line items, the user may scroll through the claim line 
items one line at a time or one page (i.e., 6 lines) at a time using the buttons provided 
along the right edge of this tab. 

The up/down arrow keys can be utilized to move from line to line, scrolling when 
appropriate. Type "<ALT><PAGE UP>" (press the "Page Up" key while holding the 
"ALT" key down) or "<ALT><PAGE DOWN>" to scroll up/down through all claim line 
items one page at a time. 

• Line Item Features - The following productivity features are available on the Billing 
Line Items tab: 

• Field Duplication -- Press the "F4" key while positioned on a specific field on a line to 
copy the value of that single field from the previous line into the current line  

• Line Duplication - Press the "F5" key while positioned on any field on a line to copy 
the values in all fields of the previous line into the current line. 

• Line Deletion - Press the "F7" key while positioned on any field on a line to delete the 
line. A prompt to confirm the deletion. Alternatively, enter the value "*DEL*" (that's an 
asterisk plus "DEL" plus another asterisk, without the double-quotes) into the HCPCS 
field on a claim line to delete the line. 

Claim lines are automatically re-sequenced by Revenue Code when a claim is saved. 
As such, there is no need to provide line rearrangement capabilities. 

• Advance To Next Line - Press the "F8" key while positioned on any field on a line to 
automatically advance the cursor to the first field of the next line, skipping over any 
remaining fields on the current line. 

• Jump To Narrative - Press the "<ALT>N" key combination while positioned on any 
field on a line to automatically jump to the Ext Details 3 (line X). Enter the desired 
narrative text and press the "<TAB>" key to return to the original line field. 

1. Line Item Totals Recalculation – The Billing Line Items tab provides a "Recalculate" 
button located near the bottom of the tab adjacent to the totals fields. Click this 
button to recalculate and update the "Total Charges" field from the current claim line item 
charges values. Select the Billing Line Items tab (Figure 65). 
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  Figure 65 
 

2. Enter the following information: (Figure 65) 

Field Name Action 
Claim Diagnosis Codes Enter up to four diagnosis codes.  
Service Dates Enter dates of service. 
PS (place of service) Press the <F2> key to show list, then select the 

appropriate value. 
EMG (Emergency) Leave field blank. 
Proc (procedure code) Enter procedure code. 
Modifiers If necessary, press the <F2> key to show list for 

appropriate values, then select modifier. 
Diagnosis Enter values 1–4. 
Charges Enter charge. Note: When entering a charge that 

includes cents, a decimal point is required (e.g., $12.01, 
$25.24). 

Units Only enter field if more than one unit. 
Rendering Phys. If billing in a group, press the <F2> key to show list of 

rendering providers of service. 
3. Select Recalculate (Figure 65). 

4. Select Save when finished entering the claim. 

5. During the claims Save operation, an edit validation process is performed on all fields. 
If no edit validation errors occur, the claim patient record is saved without further 
correction and a new Professional claim form will appear allowing entry of another 
claim.   

6. When edit validation errors occur, double-click the error message to jump to the 
corresponding field in error.  Several "Save" attempts may be required to correct and 
save a "Clean” claim.   

Refer to the "Claim & Reference File Edit Validation" topic for a more complete 
discussion of the claim edit validation process. 

7. Once finished entering claims, the claims are now ready to be prepared for 
transmission (Figure 66). See Prepare Claims Function. 

Note:  Use the Help Feature in PC-ACE for more information on “Listing, modifying and 
maintaining claims.”   
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  Figure 66 
 

Section 4 - Additional Claim Features 

Copying Claims 
Claims for the same patient can be copied and then modified instead of creating a new 
claim each time. Simply copy the previous claim, modify the dates of service and/or any 
other pertinent information, and then save it. 

1. In the Professional Claims Menu window, select List Claims. 

2. In the Professional Claim List window, in the bottom left section of the screen, choose 
the Location of TR – transmitted only. 

3. Put a check mark in the box in front of the claim(s) to be copied. 

4. On the Actions Menu, select Copy All Checked Claims. Select OK in the confirmation 
window. Note: If only one claim was checked to be copied, the Professional Claim Form 
will be displayed instead of the Professional Claim List window. 

5. Change the dates of service and Save the claim. 

6. In the bottom section of the window, select the Location of CL – to be transmitted. 
The claims will be listed and have a status of UNP. 

7. Double-click each claim in turn, enter new dates of service, and Save. 

 

Reactivating Individual Previously Transmitted Claims 

To resubmit a transmitted claim, these claims must first be reactivated. Only claims in the 
transmitted (TR) location may be reactivated. 

1. Select the Professional icon from the PC-ACE Claims Processing System main menu 
(Figure 67). 

  Figure 67 
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2. Select List Claims (Figure 68). 

  Figure 68 
 

3. Select Location (Figure 69). 

4. Select CL (to be transmitted) or TR (transmitted only). 
 

   Figure 69 

5. Check one claim or several claims to be reactivated. 

6. Select Actions (Figure 70). 

7. Select either Reactivated Claim (if only one claim) or Reactivate All Checked Claims 
(for more than one claim). 

 
 
 
 
 
 
 
 
 
 

Figure 70 
 
 
 

8. The Confirm box appears (Figure 71). 

9. Select OK to reactivate claim/claims. 
 

 
 
 
 
 
 
Figure 71 
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10. Change Location field to CL–to be transmitted (Figure 72). 

  Figure 72 

11. Reactivated claims will be listed with a status of UNP. These must be corrected before 
sending. 

12. Either double click the claim to open and make the necessary corrections and select 
Save (Figure 73), or see the Processing Reactivated or Imported Claims section to 
Process a multitude of claims. 

   Figure 73 

13. The claim status will change to CLN. These claims are now ready to be prepared and 
transmitted. See Prepare Claims instructions. 

 

Claim Import Function 

When entering claims manually in the PC-ACE software and not importing a claims file in 
an Electronic Media Claims (EMC) format, skip this section entirely. 

For more information on the importing of UB92 Version 6.0 formats and Print Image, please 
review the claim import section in the user manual. 

 

PC-ACE ANSI 837 Claim Import Capability (Importing ANSI 837 Claim Files) 
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Providers can translate and import claims files in the ANSI 837 version format, for 
subsequent editing, ANSI 837 formatting and transmission. The ANSI 837 import capability 
by default is not activated in PC-ACE. 

The Claim Import function can be utilized for MSP claims that need to be updated or 
corrected and your claims software is not capable of doing so. 

This feature should only be activated if the ANSI 837 files have already been validated as 
structurally sound and complete. It should not be used as an ANSI 837 testing validation 
tool. 

Note: Only those data elements supported in PC-ACE will be imported from the ANSI 837 file. 
Any unsupported segments and data elements present in the imported ANSI 837 file will be 
ignored. 

To activate this feature for importing ANSI 837 4010A1X12 files, perform the following: 

1. From the PC-ACE main toolbar select File, then Preferences menu items and login 
when prompted (Figure 74). 

 Figure 74 

2. While viewing the Preferences screen, type the ampersand (&) character (i.e., 
<SHIFT>7). An additional tab labeled System will appear. 

3. Select the System tab and check the Enable Professional ANSI 837 claim import 
function option. 

4. Select OK to save the changes. These new settings will take effect immediately. (Figure 
75) 

 

 Figure 75 

5. Ensure all provider records are set up prior to importing files (See instructions on 
adding/checking a provider record). 

6. Name the claim import files with a dot DAT (.DAT) file extension and copy them into 
the C:\WINPCACE\IMP1500 directory (Figure 76). 
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Figure 76 

7. On the main toolbar select the Professional Claims Processing Menu icon (Figure 77). 

  Figure 77 

8. Select the Import Claims button (Figure 78). 
 

  Figure 78 

9. The Professional Claim Import window will appear. Select Import (Figure 79). 
 
 
 
 
 
 
 

 
 

Figure 79 
 

10. A Confirm window will be 
displayed. Select OK to continue (Figure 80). 
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Figure 80 

 
 

11. When the import process is complete an Information window will be displayed to 
indicate that the operation was completed successfully. Select OK (Figure 81). 

 
 
 
 
 

 
 

Figure 81 
 

12. The Professional Claim Import (EMC File) window will be displayed. The status bar 
indicates the operation is complete. The window should contain a count of imported 
and rejected claims as well as dollar amounts for each area. 

13. It is possible to print a report of imported claim information. Click on the View Results 
button to view the report (Figure 82). 

 Figure 82 

14. The PC-ACE Claim Import Detail Report will appear in display mode (Figure 83). 
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  Figure 83 

15. Select the printer icon to print the report or select the Close button at the top of the 
report page to exit from the report view (Figure 84). 

  Figure 84 

16. Select Close to return to the Professional Menu (EMC File). 

17. Once a file of claims has been imported the user can then run the Process Claims 
option and “scrub” all the claims for editing. Claims that are imported must be 
processed. 

 

Processing Reactivated or Imported Claims 

Claims that have been reactivated or imported need to be processed before preparing the 
claims file. Newly entered claims do not need to be processed before being prepared. 

1. On the main toolbar select the Professional Claims Processing Menu icon (Figure 85). 
 



 
 

41 

  Figure 85 
 

2. Select the Process Claims button (Figure 86). 
 

 Figure 86 
 

3. The Automated Claim Processing window will be displayed. Fill out any fields desired 
or leave all fields blank and select the Process button (Figure 87). 

 

  Figure 87 
 

LOB: The line of business of claims to be processed 

TOB: Constrain the data to process only a certain type of bill 

Provider: Constrain the data to process only the selected provider’s claims 

Present claim  
with errors: 

Check to present claims with errors for immediate editing if the claims 
were not cleaned up while in claims list 

 

4. A Confirm window will be displayed. Select OK (Figure 88). 
 

  Figure 88 

5. When the process claims is complete an Information window will be displayed to 
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indicate that the operation was completed successfully. Select the OK button (Figure 
89). 

 

 Figure 89 

6. The Automated Claim Processing window will be displayed which gives the user a 
visual of the total number of claims that were processed clean (no errors), processed 
with errors and/or unprocessed claims (like duplicates) (Figure 90). 

 

  Figure 90 

7. Select the Close button or select the View Results button. 

8. When the View Results button is selected, the Adobe Acrobat will display the report, 
select the printer icon to send the report to the printer or select Close to return to the 
Professional claims list window (Figure 91). 

 

 Figure 91 
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Reactivating an Entire Batch of Claims 
Changes cannot be made to a batch of claims that has been reactivated. This operation will restore 
the batch of claims so that it can be retransmitted. When changes need to be made to claims that 
have already been transmitted, see the section titled Reactivating Claims. 

1. In the Professional Claims Menu window, select the Maintain Menu and select
Transmission Log.  The Professional Claims Transmission Log window will be
displayed.

2. Select the batch of claims to reactivate. When uncertain which batch should be
selected, highlight the line, then select the View Details button to see Transmission
Detail report for the batch.

3. Once it has been determined which batch of claims to reactivate, highlight the line
and select the Reactivate button. Read each window that pops up, then select OK in
each.

4. Do not prepare the claims file when reactivating an entire batch of claims.  Simply
transmit the claims file as normal.

Section 5 - Prepare Claims Function 

Medicare claims must be prepared and transmitted using communication software before 
another batch can be prepared. Failure to follow these instructions will overwrite the 
previous claim file. When ready to prepare claims for transmission, do the following: 

1. Select PROF from the PC-ACE Claims Processing System main menu (Figure 92).

a.   Figure 92 

2. Select Prepare Claims (Figure 93).

a.  Figure 93 

3. The Professional Claims Prepare for Transmission box appears Select Prepare Claims.
(Figure 94).
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a.  Figure 94 
 

4. The Confirm box appears and states, “Ready to prepare selected Professional claims 
for transmission?” Select OK.  (Figure 95). 

a.   Figure 95 

5. The Information box appears and states, “The claim operation has completed 
successfully.” Select OK. (Figure 96). 

 

  Figure 96 

6. The Claim Prepare for Transmission box appears (Figure 97). 

7. Select View Results. 
 
 
 
 
 
 
 
 
 
 
                                                                                                     Figure 97 
 
 

8. PC-ACE Transmission Detail Report will appear. To print this report, select the Print 
icon (top of tool bar, to the left of the Close button). This report does not confirm 
the transmission of claims. (Figure 98) 
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a.  Figure 98 

9. The preparation of claims has now been completed. Prepared claims must be 
transmitted. Continue to the transmission process using the NSV’s software. 

Section 6 - Transmission Process 

Network Service Vendor  
All submitters should connect through a NSV and follow their connection/transmission instructions 
provided by the NSV to send and receive files. 

Note: For Part B, the claims file to be transmitted created by PC-ACE will be named BTRANS.DAT by 
default and will be located in the C:\WINPCACE directory. 

Please see the list of NSVs listed on our website under the Resources > EDI Enrollment (on right 
side of page) if one has not already been selected. 

 

Transmission Reports 
Once the claim file has been sent, three reports (TRN, 999 and 277CA) will be available for 
download. 

TRN–Transaction Acknowledgement (available within a few minutes after transmission.  
Note: Some network software vendors do not update or refresh right away. The file may 
take 15 minutes or so to become available for download). 

• Look for “No input validation problems subsequent reports to follow” (Figure 99). 

Contact the NGS EDI Help Desk if any errors appear: 

o J6: 877-273-4334 

o JK: 888-379-9132 
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Figure 99 
 
999 and 277CA Reports: 

999 and 277CA files must first be imported into PC-ACE in order to view them in a 
readable format (available up to two hours following transmission). 

Importing and Reading the 999 and 277CA Reports 

1. Open PC-ACE and click on File then Preferences (Figure 100). 
 

  Figure 100 

2. Check the first box highlighted. To view only rejected claims in the 277CA report, check 
the second highlighted box also. To view both accepted and rejected claims in the 
277CA report, leave the second box unchecked (Figure 101). 

 

  Figure 101 
 

3. In order for PC-ACE to read 999 or 277CA files, they must be saved into the proper sub- 
folder within the WINPCACE folder (Figure 102): 

277CA files need to be saved in the Stat1500 (Part B) subfolder of the ANSI 277 folder. 
999 files need to be saved in the Ack1500 (Part B) subfolder of the ANSI 997 Folder. 
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  Figure 102 
Note: This process can be set to run from a batch command file. See Appendix A at 
the end of this document for instructions. 

4. Once the report files have been moved to the proper folder location, go to the 
Professional Claims Menu. Select the Maintain menu item, then Acknowledgement 
File Log to read the 999 (Figure 103). 

 Figure 103 
 

5. The following screen will be displayed to read the 999. From the Acknowledgement 
File Log screen, select the 999 to be displayed and select View Report (Figure 104). 

See Appendix A for instructions on how to adjust the length of time archived copies 
are maintained in the system. 
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 Figure 104 
 

• Look for (Figure 105): 
Transaction Set Status (IK501): A - Accepted  
Functional Group Status (AK901): A - Accepted 

• If the 999 is rejected, no further editing is done and no further reports are created. 
• If the 999 is accepted or accepted with errors, a third report will be received (the 

277CA report) 
• To print the report, select the Print icon. 

  Figure 105 

6. To read the 277CA, from the Professional Claim Menu, select Maintain and Claim 
Acknowledgement Log (Figure 106). 

  Figure 106 
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The following screen will be displayed to read the 277CA.  From the Acknowledgement File 
Log screen, select the 277CA to be displayed and select View Ack Report (Figure 107). 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 107 
 
 

Look for Total Accepted Quantity.  Any claims that reject will need to be corrected and 
resubmitted (Figure 108): 

  Figure 108 
 

Scroll down to the Claim Acknowledgement for the patient information on each claim and 
it will show all the details for each claim submitted (Figure 109). 
• Claim number 
• Patient name/number 
• Provider NPI 
• HIC Number 
• ICN/DCN 
• Total charges 
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Figure 109 
 
 
 

Appendix A: Adjusting Archived Reports Settings 

The length of time that archived copies of 999 and 277CA files are kept can be adjusted. 
From the main menu of PC-ACE, go to File, Preferences, and click the Misc tab (Figure 110). 

If desired, adjust the first two fields to indicate how long to keep the archived reports. The 
duration has been set to 1000 days in the example below. 

   Figure 110 

 

Appendix B: Setting up Shortcuts for File Locations 

To assist in the placement of new reports shortcuts can be created (Figure 111). 
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       Figure 111 
 

Click on Windows symbol and locate Windows Systems then select File Explore (Figure 112). 
 

 
      Figure 112 
 
 

 
Locate WINPCACE under Windows ©: Double click on the WINPCACE folder (Figure 113). 
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Figure 113 
 

Double click on the ANSI 277 folder for a 277 shortcut. If desired, repeat this process for A 
999 shortcut in which the 997 folder should be selected (Figure 114). 

Figure 114 
 

Right click Stat1500 folder for Part B (Figure 115). 
 

  Figure 115 
 

Select Send To and then Select Desktop (create shortcut) 
 

Right click on the new folder and rename the folder (i.e., 277CA Reports) with the new folder 
on the desktop, place all 277CA reports into this folder. 
 

To create a shortcut for 999 reports, repeat this process however, instead of selecting the 
ANIS277 folder select the ANSI997 folder and continue follow this process by renaming the 
folder (i.e., 999 Reports). 
 

For further assistance please send an e-mail to EDI at ngs_edi_parta@anthem.com or 
contact the EDI Help Desk: 

• J6: 877-273-4334 
• JK: 888-379-9132 

Appendix C: Troubleshooting 

When experiencing problems viewing 999 or 277CA reports, once saved in the correct 
subdirectory in PC-ACE, it is suggested that a system change be made. 
 
Select Start from the desktop, then go to the Control Panel select Folder Options 

mailto:ngs_edi_parta@anthem.com
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Select the View tab  
 
Under Hidden Files and Folders click on the Hide extensions for known file and folders 
check box, in order to remove the selection of that option, then click on the Show hidden 
files and folders radio button to change settings (Figure 116). 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
Figure 116 

 

 

This will show any hidden file(s) in the WINPCACE directory. 
 

Section 7 - How to Backup PC-ACE Claims Processing System 

Each time the program is exited the following message will appear: “ Perform System 
Backup?” An external backup file of the program must be maintained in the event a fatal 
system crash occurs. 
 

1. To do this, the backup may be placed on the desktop by selecting the Browse button 
and choosing the hard drive (system C) and desktop (Figure 117 and 118). 
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  Figure 117 
 
 

  Figure 118 
 

2. This will put the backup file named PCACEPBK.ZIP on to the desktop (Figure 119). 
 

  Figure 119 
 

3. From the desktop, save to a CD-ROM or flash drive. This external device must be 
maintained to ensure the restore capabilities in the event of a fatal system crash. 
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4. Select My Computer on the desktop and drag the PCACEPK.ZIP file from the desktop 
to the CD-ROM and then burn it, or drag to the flash drive (Figure 120). 

 

 

 

 

 

 

 

 

 
 

 

 

 

Figure 
120 

 

Section 8 - Additional Features 

Archiving Claims 
Archiving claims in PC-ACE improves performance and helps prevent database corruption. 

1. Select the Prof button on the main toolbar. 

2. Select the List Claims button. 

3. Select the File from the Menu at the top of the screen 

4. Select Maintain Claim Archives 

5. Select the New button and enter a name for the archive, then select OK. 

6. Select the Close button.  The Professional Claim List window will appear. 

7. In the Claims List Filter Options section at the bottom of the Professional Claim List 
window, select the drop down arrow and select TR-transmitted only. 

8. Select the Advanced Filter Options button near the bottom of the Professional 
Claim List window, and enter the filter criteria.  
Example: If today’s date is March 13, 2014, to archive everything except the past three 
months, do the following: 
a. Check the box in front of “Invert filter logic…” at the bottom of the Advanced 

Claim List Filter Criteria window.   
b. Enter “01/01/2014” in the first box in the Transmit Date: field, then enter 

“3/13/2014” in the second box.  
c. Select OK. 
d. The Professional Claim List window appears and the only claims displayed are 

those that were transmitted more than three months ago. These are the claims to 
be archived. 

9. Select Filter from the Menu at the top of the screen and select Check All Claims. Each 
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claim now has a checkmark in the box at the left of the line it is on.  

10. Select the File Menu and select Open Claim Archive 

11. Double-click the archive that was created in the steps above. An information window 
will pop up. Read the contents, then select OK. 

12. Select the Actions Menu and select Archive All Checked Claims (near the bottom of 
the Actions menu.) Do not select Archive Selected Claim, as that will only archive the 
claim that is highlighted.  

13. An information window will appear. Read the contents, and then select OK. 

14. The claims are no longer shown in the list. They are not gone; they have been stored in 
the archive. To see these claims, select the File menu, and then select View Archived 
Claims.  

Note:  Do the following to view these claims again once PC-ACE has been exited:  

a. Open the claims list 
b. Select the File Menu and select Open Claim Archive.  
c. Double-click the archive to view, read the information in the pop-up information 

window, and select OK. 
d. Select the File Menu and select View Archived Claims. 
e. To see current claims, select the File Menu and select View Current Claims. 

 

Transferring PC-ACE to Another Computer 

1. On the old computer, upgrade PC-ACE to the current version. 

2. On the new computer, install the full installation of the current version from our Web 
site. 

3. On the old computer, open PC-ACE. 

4. On the main toolbar, select the last button, which has a gear and a wrench on a 
French flag. 

5. Sign in. The System Utilities window is displayed, the Backup/Restore tab should be 
selected and the Backup sub tab displays the text “This utility performs a backup…” 

6. Select the small button with three dots on it at the right end of the Destination Drive 
or Folder field. 

7. In the Select Backup Destination Directory window, select the drop down arrow at the 
right end of the “Look in” field, select Desktop which should be at the very top of the 
list, then select the Open button. The System Utilities window will be displayed. 

8. Select the Start Backup button and select the OK button in the Confirm window. 
9. After the backup operation completes, the Information window will display. If the text 

states “The backup operation has completed successfully” then select the OK button. 
Note: If the text indicates that the backup failed, please contact the NGS EDI Help 
Desk: 
J6: 877-273-4334  
JK: 888-379-9132. 

10. In the System Utilities window, select the Validate sub tab, browse to the Desktop as 
in the earlier steps, then select the Start Validate button, select the OK button in the 
Confirm window. When the validation is complete, the Information window will be 
displayed with the text “The validation operation has completed successfully:” 
Note: If the text indicates that the validation failed, please contact the NGS EDI Help 
Desk. 

11. Select the OK button in the Information window and select the Close button in the 
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System Utilities window. 

12. The backup file on the desktop is named PCACEPBK.ZIP. Copy this file to the Desktop 
of the new computer. 

13. On the new computer, open PC-ACE and on the main toolbar, select the last button, 
which has a gear and a wrench on a French flag (as directed above). 

14. Sign in. The System Utilities window is displayed, the Backup/Restore tab should be 
selected and the Backup sub tab displays the text “This utility performs a backup…” 

15. Select the Restore sub tab, browse to the Desktop, and select the Open button. It is 
not necessary to select the file because the program knows the file name already. 

16. Continue with the restore, following the prompts. Once it’s complete, PC-ACE on the 
new computer is identical to what was on the old computer. 
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